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In this manual, we will indicate the pop-up menus as following : File > 
Save As. The first part before the sign “>” is the menu from the menu 
bar. The second is a command that you can choose within this menu.

You can visit our web site www.softronmedia.com for informations 
about the updates and to contact us for support.

Remarks
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IPart I :  About
OnTheAir Video

In this first part, we will present you briefly OnTheAir Video. We will 
inform you about the different video Formats supported, the possible 
configurations and how to install the software and start it.
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What is
OnTheAir Video 1
OnTheAir Video (OTAV) is an OS X software that enables you to read 
and broadcasts almost any video clips exported directly from Final 
Cut Pro or any Editing software. It can be used by televisions for 
program broadcast, or as video player for news or live programs. It 
is also aimed to be used for live shows, exhibitions, trade shows and 
so on.  

The OnTheAir Video User Interface has been designed to be easy 
to use. A nice and easy to use Interface is the key of the success of 
OnTheAir Video.

OnTheAir Video is also very flexible, it supports multiple formats 
in PAL and NTSC. None of the codecs supported are proprietary, 
which means an easier integration with past, present and up-coming 
systems. A simple Quicktime export from Final Cut Pro and your file 
is ready to be aired without having to compress or convert it.

OnTheAir Video doesn’t need any proprietary Hardware neither. A 
recent PowerMac and a Video Card are just what you need to start 
broadcasting (and of course some videos!). For higher capacity 
needs, you will need a Fibre Channel RAID server (Apple Xserve Raid 
for example).

The playlists used by OnTheAir Video are in XML. OnTheAir Video 
can therefore easily be integrated to traffic or Automated systems. 
For these products, you can also have a look at other of our 
products. TVPlanner and TVScheduler are Traffic and Automation 
Softwares also based on the Mac Platform with the same spirit as 
OnTheAir Video.

OnTheAir Video is based on a Macintosh/Unix architecture known 
for their reliability and flexibility. All solutions developed by Softron 
Media Services are fully tested and approved before you get it. A fast 
and personalized support is also what we do best.

Simplicity 

Flexibility

Security
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System Requirements 2

Computer

OnTheAir Video requests :

Video/Audio output

Video Card Version
OnTheAir Video needs a Video Card for the output of the Video and 
Audio signals. Today, some cards have been fully tested :

Other cards can be supported but have not been tested thoroughly. 
Other cards will be tested and approved compatibility will be 
updated on our web site: www.softronmedia.com.

Firewire Version 
The Firewire Version of OnTheAir Video can work with any Firewire 
Convertor. You can even connect several convertors and get as 
much video output as you have convertors connected. However, you 
will be limited to your system, and specially Hard Disk limitations. 
Contact us to know how many convertors you can use on your 
system.

Withn this version, you have the advantage to be able to have 
several video streams on one machine and to implement this also 
on a PowerBook or even an iBook. But what you will not get with 
this version is: no support for other formats than dv stream, no logo 
overlay, no Scheduling function.

Macintosh computer with a 1.8GHz or faster PowerPC G5 
processor; not supported on Intel-based Mac computers with 
Rosetta.
Minimum 1,5 Gb RAM.
Mac OS X v10.3.9 or Mac OS X v10.4 or later
Quicktime 6.5.2 or later

•

•
•
•

Blackmagic Design cards (DecklinkTM, Decklink ProTM, Decklink 
SPTM, Decklink ExtremeTM, + Decklink HD...)
Aurora Video Systems cards (Aurora PipeTM, PipeProTM, 
PipeSDITM, PipeStudioTM, ...)

•

•
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Storage

You can use OnTheAir Video with the internal disks of your Mac. 
But if you must use a large quantity of files or in High Definition, 
we would advise you to work with Apple’s XServe Raids which are 
entirely supported by OnTheAir Video.
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Supported Formats 3

At the redaction of this Manual, these formats have been entirely 
tested and are therefore entirely supported (all these formats can be 
used in the same playlist) :
• 
• 
• 
• 
• 
• 
•
• 

A lot of other Quicktime Formats can be supported by OnTheAir 
Video. They are just not entirely tested yet. If you want to use 
another format than the ones specified, you can check on our web 
site if there has been any update and you can of course test it by 
yourself.

Today, only these 3 formats will not be supported:

Do not hesitate to test different formats and to keep us informed on 
your tests and comments by mail at: info@softronmedia.com

DV STREAM
DV
MPEG-4
DVCPRO-25
DVCPRO-50
M-JPEG
DVCPRO-HD
IMX

H.264
MPEG-2
HDV

•
•
•
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Getting started with 
OnTheAir Video 4

To install OnTheAir Video, double-click on the installer and follow the 
instructions on screen.

A USB dongle will be required to use OnTheAir Video. 
Without this USB dongle, you will run in DEMO mode: only 
the first 15 seconds of the clips will be played and you will 

not be able to use the Schedule mode.

On the first use of OnTheAir Video, don’t forget to check the 
settings of your video card in “System Preferences”. To set these 
preferences, go to Chapter 6, page 21.

To start the application, just double-click on the icon situated in the 
Applications Folder.

Once started, check if the Application preferences in the Menu 
OnTheAir Video > Preferences are properly set up for your use. Be 
aware that some preferences like the “Logo Folder”, have to be set 
in order for OnTheAir to work properly. For more details on these 
preferences, go to Chapter 7. 
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Examples of 
Configurations 5
Here are some examples of configurations. Of course, these are only 
examples and as OnTheAir Video uses non proprietary Hardware, 
there are a lot of possibilities from even simpler to much more 
complicated solutions.

Do not hesitate to contact us to validate your configuration at 
info@softronmedia.com.

PowerMac G5

Video Card
(Decklink or Aurora)

XServe RAID 
(storage)

Fibre Channel Card

XServe (Server)

XSan

Switch Fibre Channel

Configuration 1 Configuration 2 Configuration 3

X

X

X

X

X

X

X

X

X

X

X

X

X

X
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Configuration 1 (Basic)

Configuration 1 can be used quickly with simply a PowerMac, a Video 
Card (Decklink or Aurora), the software OnTheAir Video and the USB 
dongle delivered on purchase of your license.

Configuration 2 (Normal)

Configuration 2 can improve the storage capacity, simply by adding 
in direct attach an Apple XServe RAID with capacities of several 
Terabytes.

In these first two configurations, you can connect the Mac to the 
Network with the built-in Ethernet Port. The Mac will be the bridge 
between the Xserve Raid and your local Network. Thus the users on 
your network will be able to drop files on your Xserve Raid.

Configuration 3 (Advanced)

Configuration 3 adds a highly secured and efficient SAN. This 
configuration is required to users who needs a guaranteed playout of 
their clips AND a high availability of the same files through Network to 
other users such as editors. 

With this configuration, you will be using Xsan which enables to share 
files on a Xserve RAID through Fibre Channel. With this solution, the 
playout Mac is not anymore a “bridge” for the network and cannot be 
influenced by activity on the Network. The playout Mac is a Client of 
the Xsan as the other machines are.

 If you use the Mac as a bridge for access from the 
Network, beware that the activity of the Network might slow 

down your Mac, and therefore Video might drop frames 
with high activity of the Network. For higher availability, 
best performance, and a drop-frame proof option with 

Network access, we strongly recommend you to use Xsan 
with configuration 3. Anyhow, contact us to validate your 

configuration according to your use.
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This solution requires the implementation of a Fibre Channel Network 
(Switch + Cables + Fibre Channel cards on each computer). The 
Fibre Channel Network is much more Fast than the Ethernet Network, 
specially for big files like Video Files. A Fibre Channel Network is 
dedicated to the transfer of these large files and, it is not open to all 
the computers on the NEtwork and therefor, can not be disturbed by 
the Network activity of the other computers using Mail, chat, internet, 
small file exchanges...

For all these reason consider your needs and your use before 
choosing a solution. Again, do not hesitate to contact us for your 
configuration, for more info and help at info@softronmedia.com. We 
will help you to figure out the best solution for you.
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IIPart II : Setting up
preferences

In this second part, we will explain how to set up the Video Cards 
Preferences as well as OnTheAir Video Preferences.

Please read attentively this part! Not only to set up correctly 
your Hardware and software before use, but also because some 
informations given here in the preferences will be helpful in your 
every day use of OnTheAir Video.
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Video Cards Preferences 6

 As it is impossible for us to know at the redaction of this 
manual what will be the evolutions of the hardware in the 
future, the names, screen captures and set ups given here 
are only given for your information and help. However, we 
recommend you to check with your supplier for the latest 

info on the cards you will be using.

After having installed the latest drivers of the cards (check on the 
manufacturer’s site), the first thing to do is to open the Display 
Preferences. For that, click on Apple Menu > System Preferences. 
Then select “Displays” and check the option: “Show displays in Menu 
Bar”. Close this window and click on the icon representing a Display at 
the right of the Menu Bar. In the part named “Television”, check that 
the card is set on 25Hz if you are working in PAL and on 30Hz if you 
are working in NTSC.
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System Info
This part contains information about your computer. This data is 
useful to check if your system is up-to-date and to know quickly its 
main characteristics, such as RAM...

PipePro

Desktop/InterceptorTM Control

Aurora PipePro

To set up the preferences of the Aurora Card, click on the Apple Menu 
> System Preferences, and then click on the icon “Aurora” at the 
bottom.

If used with OnTheAir Video, let this option set 
on “Disabled”. Any other mode might generate 

interferences.

« Desktop Only», when no application requires the Video 
Output, the card will be used as a second Display output for your 
computer.
« Desktop & InterceptorTM » with Interceptor mode on, as soon 
as a Quicktime application is launched, the card will try to output 
the video signal. Do not ever activate this mode when using it with 
OnTheAir Video!
« Disabled », when no application requires the Video Output, the 
outgoing signal will be black.

•

•

•
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Desktop/InterceptorTM Mode

Still Field Control
A video image is composed of two frames, so when you output video 
on pause, you can choose to output the two frames or to output only 
one frame. This last choice will avoid aliasing in moving elements.

NTSC Mode
In these settings, you can choose between the NTSC mode used in 
Japan and the one used in the United States.

Genlock Control
Indicates the Genlock mode :  

Component Video Output

Unbalanced/Balanced Audio Outputs
These settings will be activated only if you have a card with balanced 
and unbalanced audio outputs. The Aurora Pipe Studio for example 
has the possibility to output these two kinds of signal.

« Upper Field First  - Full Bandwidth » This is the setting to be 
used with OnTheAir Video. It sets the Field Order.
« Lower Field First – Half Bandwidth », « Lower Field First – Half 
Bandwidth » and « Upper Field First – Half Bandwidth », are other 
field order and bandwidth settings to be used in other applications. 
Check with the application and/or format you use for the right 
settings to use.

•

•

« Unlocked » if the Video card doesn’t receive any Genlock signal, 
this setting is set by default on “Unlocked”. 
« Locked » if the Video Card receives a Genlock signal, you will 
then be able to choose to synchronize your signal on the reference 
signal or not. This setting is widely recommended if you use 
OnTheAir Video in a production room in which the signal has to be 
in sync with others from cameras, VTRs...

•

•

« RGB SD » sets the video output mode in RGB.
« YUV SD » sets the video output mode in YUV.

•
•
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Blackmagic-design : Decklink Extreme

To set up the preferences of the Aurora Card, click on the Apple Menu 
> System Preferences, and then click on the icon “Decklink” at the 
bottom.

Video & Audio
Decklink Video Connections / Output

If you output your signal in SDI, both setting will work fine.

Decklink Video Connections / Input

Genlock Timing
This option can correct the synchro with an external Genlock.

HDTV Up/Down Convertor
It is possible here to downconvert a signal. For example, you can 
downconvert an HD signal to a SD signal so that you can monitor an 
HD signal on a SD monitor (with a loss of resolution of course).

« SDI & Analog NTSC/PAL (Y, B-Y, R-Y) » this setting must be used 
if you output Video on an analog Component and/or SDI output.
« SDI & Analog NTSC/PAL (Y Out) » this setting must be used if 
you output Video on an analog Composite and/or SDI output.

•

•

« SDI Video & SDI Audio » use this setting to Capture footage 
through your SDI Video/Audio input.
« Y, B-Y, R-Y Video & Analog XLR Audio » use this setting to 
Capture footage through the Analog Component Video input, and 
the Analog XLR Audio input.
« NTSC / PAL (Yin) & Analog XLR Audio » use this setting to 
Capture footage through the Analog Composite Video input, and 
the Analog XLR Audio input.

•

•

•
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Black Video Output to Deck in Capture

NTSC Setup
Whether you’ll be using the card in the US or in Japan, change the 
settings here.

Video Desktop
BEWARE, switching from one Mode to another will require you to 
restart the computer for the changes to take place.

Video Output from Legacy Applications
With this option enabled, as soon as an application using Quicktime 
will be launched, the card will try to output its Video signal.

When using you decklink card with OnTheAir Video, 
set this option on “Disabled after restart” because it 

might have interferences with OnTheAir Video.

Again, be sure that this option is disabled, or you 
might have interferences with OnTheAir Video.

« Enabled After Restart », when no other application requires 
the Video output of your Decklink, the Video Card output will be 
used as a second monitor. You will then be able to configure de 
Desktop picture and the position of this second monitor in “System 
Preferences > Displays”. 
« Disabled After Restart », when no other application requires 
the Video output of your Decklink, the Card‘s video output will be 
black.

•

•

« ON SDI Digital Out » choose this to output a Black stable syn-
chro signal on the SDI output.
« On Analog Out » choose this to output a Black stable synchro 
signal on the Analog Video output.

•

•
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VANC & 3 :2 Pull Down
Please refer to the Decklink User Manual for the use of these options.

Proc Amp
Please refer to the Decklink User Manual for the use of these options.
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Setting up
OnTheAir Video 7
To access the OnTheAir Video preferences, open the application, then 
click on the menu “OnTheAir Video” and select “Preferences”.

Defaults

Here you can set the Default settings of the playlists and clips. Every 
new playlist created will have by default the settings indicated here.

Create a new empty playlist at startup
With this option checked, OnTheAir Video will create a new empty 
playlist when you will start the application.

Loop by default
When the Loop mode is checked, it means that every new playlist 
created will be in Loop Mode which means that at the end of the 
playlist, it will start again from the beginning. If unchecked, the 
playlist will stop at last clip.

Chain by default
When chain mode is checked, every new playlist will be in chain 
mode, which means that once a clip is finished, OnTheAir Video will 
play the next one. If unchecked, OnTheAir Video will stop playing at 
the end of each clip.

These default settings will only apply to the new playlist you 
will create and NOT to the ones already created.
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Cue by default
When a playlist is NOT in Cue Mode, when you double-click on a clip, 
it will start to play immediately. When this option is checked, when 
you double-click on a clip, it will pause on the first frame of the clip 
waiting for you to press the space bar or to click the play button to 
start playing. This mode is very useful when used in a production 
room for news or games. You can then prepare your subject and 
launch it once the journalist has announced it. If chain mode is NOT 
activated, it will stop at the end of the clip and select the next one. If 
chain mode is activated, it will play the next clip.

Default clip end behavior
This option sets the way OnTheAir Video must react at the end of a 
clip when you create the playlist:

Generate « as-run » logs
You can choose if you want OnTheAir Video to generate “As-run 
logs”. They are generated in the same folder as the Application. 
One different file is generated every day. These “As-run logs” are 
referencing all the clips played by OnTheAir Video. You can use this 
as a report for your clients to know when their clips have been aired. 
What is referenced is: the date, hour, the name of the playlist and 
the action (if the clip was played next to a clip or if it was launched 
manually or with a schedule action).

The individual clips settings will be applied whatever the 
playlist settings are: if your playlist is in chain mode BUT 

one of your clips is set to “Stop At End”, the playlist will stop 
playing at the end of this clip.

•

•

•
•

•

Normal : Follows the behavior set for the playlist: If the playlist is in 
chain at the end of the clip, the next clip will be played, if playlist is 
not in chain mode, it will stop at the end of the clip.
Stop At End : stops playing at the end of the clip (even if the 
playlist is in chain mode.
Hold Last Frame : pause on the last frame of the clip.
Play Next Clip : play the next clip in the playlist (even if the playlist 
is not in chain mode).
Loop : at the end of the clip, OnTheAir Video will play it back from 
the beginning.
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Display Clip Last Modification Date and Time
This option allow you to show informations concerning the Clip last 
modification Date and Time. These Display of these informations can 
be personalized. For that you must enter in the “format” area the 
conversions specifiers corresponding to the information you’d like to 
see in your playlists.

Here is the list of the conversion specifiers:

Specifier Description

%% a ‘%’ character

%x Date using the local date format

%X Hour using the local date format

%c Shorthand for %X %x, Date and Time using the local format

%Y Years with century (such as 2006)

%y Years without century (00-99)

%B Full month name

%b Abbreviated month name

%m Month as a decimal number (01-12)

%A Full day name

%a Abbreviated day name

%w Day as a decimal number (0-6), where Sunday is 0

%d Month as a decimal number (01-31)

%e Same as %d but does not print the leading 0 for numbers 1 to 9

%j Day of the year as a decimal number (001-366)

%H Hour based on a 24-hour clock as a decimal number (00-23)

%I Hour based on a 12-hour clock as a decimal number (01-12)

%p AM/PM designation for the locale

%M Minute as a decimal number (00-59)

%S Second as a decimal number (00-59)

%F Milliseconds as a decimal number (000-999)

%Z Time zone name (such as Pacific Daylight Time)

%z Time zone offset in hours and minutes from GMT (HHMM)

So, if for example, you’d like to see the name of day, the date, the 
time with milliseconds at which the clip was last modified, you’ll have 
to enter in the “Format” area:
%A, %c:%F (this might show as: Monday 20-02-2006, 16:31:15:699)

Beware that these indications concern the Modification of the file in 
itself, not the clip in the playlist. If you modified the in/out points in 
the playlist, this won’t modify the Modification Date. But if you modify 
your clip with QuickTime for example and save it, this will change the 
modification date and time informations.
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Playback

In Playback, you can set the preferences of output of the Video and 
Audio Signal.

Video Standard
Sets the broadcast standard : PAL or NTSC.

Video Output
Sets the output on which the Video signal must be sent: you must set 
or Blackmagic Video Output, or Aurora Video Output.

Video Mode
Sets the Video Mode (8bit or 10bit, PAL or NTSC). Choose 8bit, PAL or 
NTSC.

Audio Output
Sets the output on which the Audio Signal must be sent: Or 
Blackmagic Audio, or Aurora Audio output, or the Built-In Audio 
output. If you choose “Built-In Audio” for your Audio output, beware 
that there will be a desynchro between the audio and the video due 
to the process time of the video signal.

Playback Buffer
Sets the length of the buffer. The more your connections with the 
video source files is stable, the more you can shorten the buffer 
length. However, we recommend to set this on 10 seconds. 

When a clip is “buffered”, it is then locked in the playlist. 
Which means it can not be moved or deleted. So, by default, 
the next clip will be locked during the last 10 seconds of the 
playing clip. If your buffer is longer, then the next clip will be 

locked for a longer time as well.
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TimeCode

It is possible to start playing an individual clip in sync with an external 
TimeCode. This TimeCode can be given or by the internal clock, or 
by an External Source. For an external source, you need a proper 
LTC-serial converter connected to the serial (RS-422) port of the 
Video card. OnTheAir Video currently only support the AEC-Box1 from 
Adrienne Electronics.

TC Source
Sets the source of the TimeCode: or the internal Clock, or an external 
generator coming through the RS-422 port of the Video Card.

TC Offset
Sets the offset with which OnTheAir Video launches the clip. In the 
example below, OnTheAir Video will play the clip 13 frames before the 
TimeCode indicated in the playlist.

Show TC in a floating window
Shows a floating window with the TimeCode data in big.

More info on the use of TimeCode page 39.

Do NOT use the TimeCode option in association with a 
Schedule! It might have unpredictable effects.

Do NOT activate External TimeCode with no valid external 
TimeCode Connected!
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Logo

With OnTheAir Video, you can overlay logos and graphics files. These 
graphics must be saved in png format, RGB, with a resolution of 720 
width, 576 height, 72 dpi. Beware that the File Name must end with 
.png, otherwise OnTheAir Video will not recognize it as a good file 
format and will not overlay it!

It is possible to associate automatically graphic files to video files. So 
that every time one clip is played, one particular logo will be overlaid. 
More info on this page 44.

This function name is “logo”, but note that every kind of graphic can 
be overlaid. Therefore, you can use this option to overlay any kind of 
graphic as long as it is with transparency where you need it and in the 
right format.

Default Logo
Indicates the logo that OnTheAir Video must overlay by default on the 
clips. It will often be your station’s logo.

Overlay Logo by default
If this option is enabled, every time you’ll add a clip in a playlist, 
the logo overlay option for this clip will be enabled. You can still 
deactivate the logo overlay by unchecking the option in the playlist.

Place all your graphics in the folder indicated in the “Folder” 
preferences. And do not forget tho set the logo Folder path 

before using OntheAir Video. More info on this page 32.
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Folders

Clip Folder
Use this preference if you want to create your playlists on a computer 
and air them with another. This is mainly the case for TV stations 
where the playlists are made on a different computer than the 
one airing the clips. Let’s say you are preparing your playlists on a 
computer A in which all the video clips are located in the folder :       
« /Volumes/DiskComputerA/Videos/clips ». 

Every time you will insert a clip in a playlist, it will be referenced with 
its entire path. So for computer A, the path referenced in the playlist 
when you save it will be : «Volumes/DiskComputerA/Videos/clipname.
mov». Then if you open the same playlist on computer B on which all 
the videos are located in «Volumes/DiskComputerB/Clips», all clips 
in the playlist will of course be offline as the path referenced in the 
playlist is the one for Computer A.

To be able to go from one computer to another with different paths 
for the same files, we implemented this option: in preferences of 
computer A :  «Folder > Clips Folder (root)», choose the folder in 
which all your video files are located. In our example : «/Volumes/
DiskComputerA/Videos/». After that, OnTheAir Video will not 
reference in the playlist this part of the path. So when you will add 
clips, instead of referencing the full path for the clip «/Volumes/
DiskComputerA/Videos/clipname.mov», OnTheAir Video will only 
reference: «clipname.mov».

Now in the preferences of computer B «Folder > Clips Folder (root)», 
you have to indicate the path where all the clips are located on this 
computer. In our example: «Volumes/DiskComputerB/Clips». When 
you will open the playlists created on computer A with computer B, 
OnTheAir Video will add the part referenced in the preferences. So 
the path referenced in the playlist was only : «clipname.mov», when 
you open it, OnTheAir video will add «Volumes/DiskComputerB/Clips». 
The full path will then be : «/Volumes/DiskComputerB/Clips/clipname.
mov». 

To be short, when opening a playlist made with computer A, in 
computer B, the part of the path referenced in the preferences of 
computer A is replaced by the part of the path referenced in the 
preferences of computer B.
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Overlay Logos Folder
This is where is indicated the place where OnTheAir Video will find 
all the logos used by the user. This is from this folder that OnTheAir 
Video will constitute its list of logos when you will want to add a 
logo on a clip or set a default logo. Beware that subfolders are not 
supported yet. 

Here also, as explained concerning “Clip Folder”, you will be able to 
go from a computer A to a computer B without problem even if the 
path is not the same for the logos. You will just have to reference the 
path in this preference, and of course to have the same files in both 
computers. 

Once you have chosen a folder in the preference «Folder > 
Clips Folder (root)», you will not be able to add files from 
another folder! All your video files will have to be in this 

folder. BUT of course you can have subfolders in this folder.

Don’t forget to choose a Logo Folder before using 
OnTheAir Video!
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IIIPart III : Using
OnTheAir Video

In this third part, we will present the user Interface of OnTheAir Video 
and how to use its advanced features.
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Overview of the 
User Interface 8

Time Indicators

The upper figures of the Timeline are giving informations about the 
time (Elapsed Time, Duration, Remaining Time) for the whole playlist. 
The lower numbers are indicating this time Information for the current 
clip.

Playlist ->

Clip ->  

Duration              
Elapsed 
Time

Remaining 
Time

The Time indicated in white to the left is the Elapsed Time.
The Time indicated in yellow to the right is the Remaining Time.
The Time indicated in blue in the middle is the Duration of the 
playlist (up) or the clip (down).

•
•
•

The two windows with bigger numbers on the left and on the right 
of this Timeline are Elapsed Time and Remaining Time indications. It 
is limited to 59 minutes 59 seconds, and above that limit, it indicates 
--:--. These windows can indicate the Remaining or Elpased Time for 
the playlist OR for the clip. To change that, right click on the numbers 
(or ctrl + click) and choose if you want these numbers to indicate the 
Elpased or Remaining Time for the Playlist or for the Clips.. 

The numbers in the left window (Elapsed Time) are in grey all the 
time, but the numbers in the right widnow (Remaining Time) are 
mainly in green, but 30 seconds before 0, it becomes orange and 10 
seconds before the end it becomes red.
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Play Modes, play control and View Modes

Play Modes
Here are the different play modes :

Playback Controls
The five Play controls are, in the order: Play next clip, Stop, Pause, 
Play, Play Next Clip.

Play Modes ->
Play Control ->
View Modes ->

Display
You can choose different Display Modes for your playlists:

« Chain » : in this mode, the clips will play one after the other in 
the order of the playlist. If unchecked, OnTheAir Video will stop 
after each clip.
« Loop » : at the end of the playlist, OnTheAir Video will go back 
to the beginning and replay the playlist. 
« Cue » : when double-clicking on a clip or when selecting a clip 
and pressing on the space bar, or clicking on “Play”, instead of 
playing immediately, the clip will be paused on the first frame. 
When pressing again the space bar (or clicking on “Play”), the clip 
will start being played. This is very useful for News and live shows 
as the subject is ready on the first frame! It should be used in 
combination with “Chain Mode”: when “Chain Mode” is activated, 
the clips will play one after the other, when inactivated, OnTheAir 
Video will stop after each clip and select the next one, so that it is 
ready to be cued.

•

•

•

« Show Thumbnails » : you can show or hide the thumbnails of 
the playlist.
« Hide Playback Controls » : you can also show or hide the 
Playback Controls. When they are hidden, it deactivates the 
Playback control for this playlist (even the space bar Play/Stop 
function), so that you can not stop a clip by error. This option is 
automatically enabled when a playlist is opened by the Scheduler. 

•

•
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If this option is checked it will add one more column in your playlist. 
In this column, you can enter the TimeCode at which you wish the 
clip to start. 

Example: If you want a clip to start at 15:37:00:00, you just need to 
encode it in the column “Auto Start TC” and the clip will start at this 
exact TimeCode.

Before using this function, you must set the Source of 
the TimeCode in the preferences : or internal (The Mac 

Clock), or External (through the RS-422 port of the 
Decklink card). 

TimeCode Start

The playlist must be opened for the clip to start 
playing at the right TimeCode.
You must deactivate the Scheduling Option when 
using the TimeCode function, because it might 
interfere one with another. The Scheduler opens 
playlists at defined Time, and the TimeCode 
Mode plays clips within an opened playlist at a 
certain Time.
The clips are automatically sorted by their “Auto 
Start TC” value. From the lowest to the highest 
value.

•

•

•
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The Playlist
 
The playlist is simply a succession of Video Clips.

The different columns are indicating :

« Start Time » indicates the relative Time at which each clip will 
start playing. It starts at 0 at the beginning of the playlist unless 
you indicate another start Time when clicking on “Playlist settings”.

« ? » or « Thumbnails » : if the option « Show thumbnails » is 
activated, this column will show the thumbnails. If the option is 
not activated, it will only indicate the playing, offline, and locked 
logos.
« Filename » : shows the name and duration of the clip.
« Logo » : when checked, a logo will be overlaid. The logo overlaid 
will be by default the one specified in the preferences. But you can 
also choose a different logo for each clip. For more info, see p.31 
for preferences settings, and p.44 for the logo options.
« Time Code » : This column is shown only if the option 
“TimeCode Start” is checked. It indicates the TimeCode at which 
the clip should be started. See P. 39, for info on this option before 
using it!

•

•

•
•

•

It is not a real start Time! It is a relative time guessed by 
adding the duration of each clip. So it has nothing to do 
with the Scheduling or TimeCode Start. It is just an indi-

cation to tell you at which Time each clip will start.
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Operations in the playlist
Within the playlists you can do several operations :

Color Codes
There are different color codes in a playlist:

A clip tinted in blue indicates it is selected.
A clip tinted in green (there will also be a green triangle on the 
Thumbnail) indicates that the clip is now playing.
A clip tinted in red (there will also be a red round sign on the 
thumbnail) indicates that OnTheAir Video didn’t find the clip. 
Maybe the clip (and/or the folder in which it was) has been moved 
or renammed. Be careful when you move, rename or delete Files 
and/or folders! OnTheAir Video checks for the clips in the playlist 
only when the playlist opens up. If you want to check it after the 
playlist has been open, press F1 or select “File > Check for missing 
clips” .
A clip preceded by a grey lock is a clip locked because it is already 
buffered. It can not be moved, nor erased. The duration of the 
buffer can be set in the preferences, and is set by default on 10 
seconds. It means that 10 seconds before the end of the playing 
clip, the next clip will be locked.

Inserting and ordering the clips by drag-and-drop. With drag-
and-drop, the clips are inserted at the top of the clip where your 
pointer is. You can organize the clips, even in a playing playlist as 
long as the clip is not locked.
Copy-paste one or more clips: Select one or more clips in a playlist 
then press “  + C”  or select “Edit > Copy”, then in another 
playlist, or the same playlist, select a clip and then press “  + V” 
or select “Edit > Paste”. The copied clips will be pasted at the top 
of the selected clip. You can also Copy-Paste one or more clips by 
holding the “alt” key while moving a clip within a playlist.

•
•

•

•

•

•
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The clips settings Drawer
 
This drawer enables you to change the settings of one ore more clips 
within a playlist. The settings are applied to all the selected clips 
(the ones in blue!). Beware that this setting doesn’t change the file 
in itself! If you change the settings of a clip in a playlist, it doesn’t 
change the settings of this same clip in other playlists. You can of 
course copy-paste the clip from a playlist to another and it will keep 
its clip settings.

« Playback » 
This option sets the way the selected clip(s) should end:

Normal : the clip will end as it is set in the Playback Mode for the 
playlist. So if the playlist is in Chain Mode, OnTheAir Video will play 
the next clip, if it is not in Chain Mode, OnTheAir Video will stop 
after playing the clip. If the playlist is in cue Mode, OnTheAir Video 
will select the next clip, ready to be cued.
Stop At End : totally stops playing at the end of the clip.
Hold Last Frame : OnTheAir Video will stay on pause on the last 
frame.
Play Next Clip : Play the next clip, even if chain mode is not active.
Loop : OnTheAir Video will go back to the beginning of the clip 
and play it back again.

•

•
•

•
•
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In/Out Points : 

In this window, you’ll have :

Beware that these settings are set only for the selected clip in this 
playlist. It will not change the in and out points of all the occurrences.

A clip preview zone.
« Current Time » : indicates the TimeCode where the cursor is 
located.
« Split Clip » : when you click on “Split Clip”, OnTheAir Video will 
split the clip in two clips in the playlist, the first one starting at the 
beginning and ending at the point where the cursor was located 
and the second one starting from the point where the cursor was 
located to the end of the clip. No New Files will be created on your 
discs. With that “Split Clip” Option, you can set different logos for  
two parts of the same clip.
« In Point » : indicates the TimeCode where the In Point is set.
« Out Point » : indicates the TimeCode where the Out Point is set.
M for « Mark » : sets the in / out point.
C for « Clear » : clears the in / out point.
G for « Go » : goes to the in / out point.
« Save as DV File » : exports the part between the in and out 
points you set as a dv File. You can save this file wherever you 
want and use it afterwards in your playlists without having to set 
its in and out points again.

•
•

•

•
•
•
•
•
•

When clicking on “Clear”, you will erase the in and out points you 
might have set earlier. 
When clicking on “Set”, OntheAir Video opens a window in which 
you can set the in and out points of the clip.

•

•
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« MIDI »
A MIDI interface can be used to control the playback of the clips. It 
can be interesting for live shows. 

To use this functionality, you must have a MIDI interface properly 
installed. Then, select a clip in the playlist and click on the button 
“learn” in the drawer and press a MIDI note on your Interface. And it 
is set! Now the next time you will press the same MIDI note, the clip 
will start playing.

Volume
For every clip you can adjust the volume. To adjust the volume, select 
one or more clip and drag the slide bar in the drawer window.

Logo Overlay
It is here that you choose the logo to overlay on one or more clip. 
Don’t forget that the logos or graphics files must be in the folder 
indicated in the preferences and that these files must be in png and in 
the resolution 720*576, 72 dpi, with extension .png at the end.

To choose which file has to be overlaid, select one or more clip and in 
the drawer, click on the logo overlay pull down menu and select the 
File you want.

You can also automatically overlay one png file on a movie file. You 
just need to name the graphic file exactly the same way as the movie 
file (except the extensions that will be different) and place it in the 
same folder as the movie file. OnTheAir Video is scanning the folders 
in which the movie files are and if it finds a graphic .png file with 
exactly the same name as a movie file, it will overlay it when playing 
it. You can still change the logo afterwards in the clip settings drawer.
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Actions
OnTheAir Video can handle actions. These Actions are in fact 
AppleScripts which are started when the clips start playing. The 
scripts must be created in AppleScript Editor and be saved in the 
Folder “Actions” in the same folder than the Application itself. 

But this option has been implemented specially to control External 
devices through GPI. This signal is sent via USB thanks to our 
GPICommander 2 Box which converts USB to GPI instructions. This 
Box is available as an option. It is compatible Mac and PC and can be 
used also by other softwares.  

For more information on Actions and GPICommander, go to Chapter 
12, page 55.

Preview
When you select a clip, you can preview it in this window. The sound 
will be output on the Built-in Audio port of your Mac.
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Playlists Creation 9
The playlist creation is relatively simple. You mainly achieve that 
using drag-and-drop between the finder and a playlist, or between 
two playlists.  The advantage of drag-and-dropping clips between two 
playlists is that the clip settings (logo, volume, in/out points...) will be 
kept.  

To create a new playlist, choose File > New Playlist or press  + N. 
Then to place the clips you want where you want them, you have 
several options:

Next to the playlist window, open a finder window (or another 
playlist window). From this window, find the clips that you want to 
use. Select a clip (or many clips), hold the click on it and move it 
in the playlist window, then release the mouse button when it is at 
the place you want it to be. This new clip will go at the top of the 
selected clip in the playlist where you dropped it.
Open two playlists and select one or more clips, then press  + 
C or choose “Edit > Copy”.  Then select the playlist in which you 
want to copy these files, and select the clip on the top of which 
you want to place them. Then press  + V or choose “Edit > 
Paste”. 
Select the clip on the top of which you want to place the new 
clips, then press  +  + N, or choose File > Add. Then select the 
clip(s) you want to add and press OK.

•

•

•

You can choose several clips by holding the apple key, 
and you can select different following clips by holding the 

shift key.
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Menus Description 10
Beware that some of the Menus are created automatically for all 
MacOsX Applications and therefore are not always used by OnTheAir 
Video.

File

New Playlist : Creates a new playlist.

Open : Opens an existing playlist.

Open Recent : Opens a list with the 5 last opened playlists among 

which you will be able to choose.

Close : Closes the current playlist.

Save : Saves the current playlist.

Save As : Saves the playlist with another name or at another 

place.

Check for missing clips : Check in the current playlist if all the clips 

can be found on the discs.

Import ASCII Playlist : Imports playlists in ASCII format. This 

format is used for interchange with automation softwares.

Export Playlist as Movie : Exports the playlist a QuickTime 

Sequence. Beware that the sequence exported will not be a self 

Contained Movie. Once exported, you will have to keep the original 

files at the same place otherwise, you won’t be able to play the 

exported file anymore.

Export Playlist as Text : Exports the playlist as a Text File. The 

export will be in the same folder as the playlist. You then have to 

save the playlist prior to Export it as Text. 

Page Setup : Set up the page for impression..

Print : Prints the playlist. Only the clips will be printed, without the 

playback controls.

•

•

•

•

•

•

•

•

•

•

•

•
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Edit

Scheduling

Window

Help

OnTheAir Video Help : Opens the OnTheAir Video Manual.

Undo : Undo an action (this option is not activated yet).

Redo : Redo an action after an Undo (not activated yet).

Cut : Cut a clip from the playlist (removes it from the playlist and 

place it in the Clip-board).

Copy : Copies the clip (leaves it in the playlist and place it in the 

clip-board).

Paste : Pastes the clip from the Clip-Board. Place it on the top of 

the selected clip.

Clear : Erases the selected clip in the playlist.

Select All : Selects all the clips in the same playlist.

•

•

•

•

•

•

•

Edit Schedule : opens the Graphic editor for the schedule (not 

available yet).

Re-read Schedule : After a modification of the Schedule File, 

re-reads the Schedule and update the changes in the Schedule 

window.

Enable Scheduling : Activate or deactivates the Scheduling 

function.

•

•

•

Minimize : Minimize the current Playlist window and place it in the 

Dock.

Bring All To front : Shows all the Playlists that were eventually 

hidden by other Applications.

At the bottom of this menu, you can also see all the opened 

Playlists. You can select and show them from here.

•

•
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Scheduling 11
The Scheduling option of OnTheAir Video is quite basic and will 
be developed in the future for it to become a graphic Scheduler. 
The Scheduler of OnTheAir Video is reading a text file in which is 
referenced the day and time start of a playlist. It is a simple text File 
with these info referenced: Date, Time and Playlist File Path.

Create a Schedule File 

To create a Schedule File, you must have a Text Editor that can make 
Lines Seizures in Macintosh Code. The file must be saved in Tab-
Separated Text Format.

Here are some examples of Applications with which you can create 
this Text File:
•   TextEdit (delivered with Mac OSX)
•   BBEdit (recommended)
•   Excel 

This File must be formatted exactly and precisely as 
indicated here. Any change in the file, date and time 

format or any other change will result in an unreadable 
file for OnTheAir Video Scheduler.

Here is an example of Schedule information:
2005-10-24 10:00:00 /Volumes/Macintosh HD/Playlist1.vpls 1 
2005-10-24 10:30:00 /Volumes/Macintosh HD/Playlist2.vpls 1 
2005-10-24 12:00:00 /Volumes/Macintosh HD/PlaylistSérie.vpls 1 
2005-10-24 12:55:00 /Volumes/Macintosh HD/PlaylistPUBS1.vpls 1
2005-10-24 13:30:00 /Volumes/Macintosh HD/PlaylistJT.vpls 1 
2005-10-24 14:00:00 /Volumes/Macintosh HD/PlaylistPUBS2.vpls 1
2005-10-24 14:05:00 /Volumes/Macintosh HD/Playlistapresmidi.vpls 1
2005-10-24 17:00:00 /Volumes/Macintosh HD/Playlist3.vpls 1 
2005-10-24 18:30:00 /Volumes/Macintosh HD/Playlist4.vpls 1 
2005-10-24 20:00:00 /Volumes/Macintosh HD/Playlist20h00.vpls 1 
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In this example, you can see that the Schedule is made of these 
elements:

These four elements are separated by a tab (ASCII 9). Every Line 
(and therefor every event) is separated by an « Enter ».

Save this file with the exact name: « Schedule.txt » at the root of the 
startup disk, and you are ready tuo use it!

Here is another example of Schedule:
2005-10-24 10:00:00 Volumes/Macintosh HD/Playlist1.vpls 1 
*  *  Volumes/Macintosh HD/Playlist2.vpls 1 
*  *  Volumes/Macintosh HD/PlaylistSérie.vpls 1 
2005-10-24 12:55:00 Volumes/Macintosh HD/PlaylistPUBS1.vpls 1
*  *  Volumes/Macintosh HD/PlaylistJT.vpls 1 
2005-10-24 14:00:00 Volumes/Macintosh HD/PlaylistPUBS2.vpls 1
*  *  Volumes/Macintosh HD/Playlistapresmidi.vpls 1
2005-10-24 17:00:00 Volumes/Macintosh HD/Playlist3.vpls 1 
2005-10-24 18:30:00 Volumes/Macintosh HD/Playlist4.vpls 1 
2005-10-24 20:00:00 Volumes/Macintosh HD/Playlist20h00.vpls 1 

In this example, we didn’t give any date or time start at lines 2, 3, 5, 
7 (but we entered the 2 Tabs). When no start date or start time is set, 
OnTheAir Video will play the next Playlist at the end of the Preceding 
Playlist. 

In this example, OnTheAir Video will start Playlist1 at 10:00 and will 
start Playlist2 at the end of Playlist1. In the first Schedule example, 
OnTheAir Video would have started Playlist2 at 10:30, even if Playlist1 
was not finished.

Beware that if you do not indicate start date and start time, you still 
have to enter the first two tabulations. At the beginning of the line, 
press Tab two times and then enter the File Path of the Playlist.

•

•

•

•

2005-10-24  =  Date of the event formatted as follow: year-
month-day (!Separators = Hyphen).
10:00:00  =  Hour of the event formatted as follow: hours:
minutes:seconds (!Separators = two points)
/Volumes/Macintosh HD/Playlist1.vpls  =  The complete File 
Path of the Playlist.
1  =  Indicates if the playlist is in LOOP mode or not: 1 means it is 
in LOOP, and 0 means it is not in LOOP.
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Using the Schedule File in OnTheAir Video

Once you created and saved correctly this file, you can use the 
Scheduling function (Beware that the Scheduling function is an option 
that you have to order).

In OnTheAir Video, the Menu “Scheduling > Enable Scheduling” so 
that you activate the option. A window named “Scheduling” should 
sow up to the right of your Monitor with the list of all the events. The 
File path of the playlist is not shown, only the name of the Playlist.

If the dates are not good in this window or if OnTheAir Video warns 
you that:

Check that the date and time formats are correct and that the lines 
seizures are in « Macintosh » (you need BBEdit to check that).

If the lines are tinted in red, it is because OnTheAir Video didn’t find 
the requested playlists at the referenced File Path. Check that the 
File Path and/or the name of the playlists are the same as the one 
referenced in the Schedule File.

After every change in the Schedule file, you must select “Scheduling 
> Re-read Schedule” or press “ + R” for OnTheAir Video to take into 
account the changes you made.
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Actions and 
GPICommander 12

GPICommander

The Application GPICommander can control one or more 
“GPICommander 2” boxes via USB. These boxes have 8 GPI outputs 
and 24 GPI inputs.

The boxes can be connected and disconnected while the Application 
is running. When a box “GPICommander 2” is connected, and if the 
software “GPICommander” is correctly installed, a window shows up, 
enabling to control the box. All inputs and outputs are seen and can 
react immediately.

Every GPICommander box has a unique Serial Number indicated at 
the top of the control window.

It is possible to control all the connected boxes manually, but you 
will surely control it via external Applications (like OnTheAir Video or 
TVPlayer).

For that use, GPICommander is entirely scriptable, which means 
that it will be controllable by other programs with AppleScripts. This 
language is widely documented and the example given here allows 
you to understand quite fast its syntax.

As indicated in the part concerning the Clips Settings Drawer, it 
is possible to start AppleScripts when a clip starts playing. These 
AppleScripts can do a lot of things and any AppleScript you made is 
supported (as long as you don’t make mistake doing it).

The Actions we are interested in here are the ones used with the 
software GPICommander and the box GPICommander 2. The software 
“GPICommander” and the box are an option of OnTheAir Video and 
it can be used by other OSX softwares than OnTheAir Video. The box 
“GPICommander 2” can work also with PCs.

We are giving you here the Manual for using the software and the 
way to create AppleScripts for this software. For more info, contact us 
at: info@softronmedia.com.
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GPICommander and AppleScript

The general idea is that you set first to whom you want to talk (to 
which Application AND to which box, AND to which input or output) 
and then to give it a command with its arguments. 

1. Tell Application
Every AppleScript talking to GPICommander will have to start with 
“tell application “GPICommander””. This command says to the 
Application GPICommander that you’d like to talk to it. The Script 
must end with “end tell” to specify that we are finished talking with it.

2. Tell Device
Then, as there might be several boxes connected, you must tell to 
which box you’d like to talk. This box can be defined by its serial 
number or by its position (if there’s only one box, you can only specify 
its position). Here also, we start with “tell first device whose serial is 
“00002951”” and we finish by “end tell” (before the “end tell” for the 
Application).

3. Tell the action
Then you’ll have to tell what action must be made on which input or 
output. Here are the actions that can be made:

You should know that:

All these Actions can be combined and used in the same Script. In the 
examples above, you can replace the inputs and outputs number, or 
replace TRUE by FALSE. You should start doing and testing your own 
scripts with the examples given with the Application GPICommander, 
and with the examples page 57.

set state of output 1 to TRUE
set state to input 1 to FALSE
set state of every output to FALSE
set state of every input to TRUE
get state of input 2
pulse output 3

•
•
•
•
•
•

TRUE = relays closed
FALSE = relays opened
pulse = sends a “pulse” of 1/60 second on one of the outputs.

•
•
•
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Examples

With two boxes GPICommander 2:
 tell application “GPICommander”
  tell first device whose serial is “00002951”
   set state of output 3  to TRUE
  end tell
 end tell

With one box GPICommander 2 (then you don’t enter the serial 
number):
 tell application “GPICommander”
  tell first device
   set state of output 3  to TRUE
  end tell
 end tell

You can also read the state of any entry:
 tell application “GPICommander”
  tell first device
   get state of input 2
  end tell
 end tell

You can of course combine the commands to make actions on 
different outputs or inputs simultaneously:
 tell application “GPICommander”
  tell first device
   set state of output 3  to TRUE
   set state of output 5  to FALSE
  end tell
 end tell

or:
 tell application “GPICommander”
  tell first device
   set state of every output  to TRUE
  end tell
 end tell

or:

 tell application “GPICommander”
  tell first device
   pulse output  3
  end tell
 end tell
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Informations and future evolutions

The syntax is not very complex and there are many Manuals on 
AppleScript so that you can learn more.

Among the coming functionnalities, it will be possible to attach 
different scripts to every input so that it will start actions according to 
the state of the inputs.

You will also be able to send informations on a serial port 
via AppleScript and the Application GPICommander (The box 
“GPICommander 2”, will not be useful anymore then).

For more informations, feel free to contact us at: 
info@softronmedia.com


